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Disclaimer
I know, I know, Nobody asked, but hear me out, 
because this is important for the whole documentation.

I AM NOT AND DO NO CLAIM TO BE A PROFESSIONAL!!!
I’m not this guru of Bryce, I’m not the Einstein of old computer art. There are (most likely) thousands of people 
better at using Bryce than me, and there are (definitely) millions of people better at 3D editing than me.

However, I do claim to know about most, if not all, of the things I mention in this guide of Bryce… well, of course 
I do, or else I wouldn’t have written it.

I am simply writing this from the passion I have for Bryce. Thank you, and please keep reading!



Segment Overview
The beauty of Bryce
This segment is the most personal of the three. 
It acts as an introduction to Bryce just in case you don’t know what it is.

The practicality of Bryce
This segment goes into most features you’ll find in Bryce 7. Most of the features in Bryce 3 are in Bryce 7, but the 
features that are exclusive to one version are mentioned as such.

The theory of Bryce
This segment focuses mainly on the art produced by Bryce. It also contains some of the techniques for Bryce.



The beauty of Bryce
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Beginning
Imagine this. An infinite azure, an oasis of nothingness, a void 
filled with water. Then, a torus, resting in the water, covered in 
chrome with a blinding shine. Then, towering stone pillars covered 
in blue moss raise out of the water, looking down on the poor, 
cowering torus. Suddenly, the sky changes mood, becoming a much 
harsher blue, painting the water in its image. Finally, as the scene 
moves around, a mountain made of lapis lazuli makes its presence 
known, and firmly finishes your scene.

Chances are, you just thought of an image like the one on the right. 
While it isn’t the most flattering sight, it captures a sort of essence 
of an age passed on. The scene was made with older technology. If 
it was made with newer technology, it might have looked fancier, 
but that retro charm would’ve disappeared.



The Essence
That’s it! That’s the beauty of Bryce! That retro aesthetic, not too bad to be a pain to the eyes, but not good enough 
to disallow disarray in a scene by considering it “out of place” or “random.” If you have Bryce, try making the scene 
I’ve just described. Once you’ve rendered it, try remaking that same scene in Blender, 3D Studio Max, Cinema 4D, 
or any other modern 3D modeling software. Don’t hold back on making it look as realistic as possible!

Now compare the scenes. The Bryce style of rendering can support all of the wackiness happening in the scene. A 
chrome torus? Massive pillars of blue moss? A mountain of lapis? These have very little to do with each other (apart 
from colour), but Bryce manages to make them work together. This Bryce render isn’t the best, but the modern 
render will look significantly worse. This is because there are only a few ways to emulate the Bryce style:

● Purposely jeopardise the render to make it look older. This can be done well, but it’s arguably easier to use 
older software than to emulate an old look with newer software. Still, exceptions exist.

● Render it as you would. This destroys the perfect balance mentioned at the start of the page. It looks too good 
to make the random elements fit, which makes the object clash heavily with the style. By consequence, it also 
ends up looking too bad to properly enjoy.



The Limits
There isn’t really a limit. Of course, anything can be made. It’s a 3D graphics software, of course 
your abilities are the limit. However, how much is too much?

Well, there is both a theoretical, as well as a practical, answer to this question.

Theoretically: there also isn’t a limit. At one point, your “scene” will become a cornucopia of 
random shapes with random textures, but this can still be made somewhat appealing. If you can 
mess something up, you can also do it right. 

Practically: Bryce, unless run on some sort of Nasa computer, will run sluggish if there is a lot of 
objects being rendered. Sometimes, just having a few objects being reflected a lot, or more 
complex geometry (Like a negative mountain, more on that in Segment 2) will make Bryce run 
significantly slower. If you have a lot of objects, your scene will render for hours or days, and if 
you plan to animate your scene, then multiply the render time by the amount of frames. Bryce 
takes no shortcuts in rendering, and it will do a full render for each frame of an animation.



Where to Begin
So you’ve seen the beauty of Bryce and want to make your own. Where to start?
Well, first you’ll need a copy of Bryce. This guide covers the two versions of
Bryce that I’m most familiar with, Being Bryce 3 and 7.

If you want to try Bryce 3, then hang on tight, because there is a full process required. Unlike Bryce 7,
Bryce 3 was made for old technology, or at least technology older than Windows 10. As such, multiple 
extra things are needed, like a virtual machine (yes, really, a virtual machine). Note that a Windows virtual 
machine is also required to run Bryce 7 on Mac, as Brce 7 is not Mac OS compatible.

As for Bryce 7, you’ll have to buy it. It’s around $20 depending on where you live.

Of course, there is another, less moral way of getting Bryce 7, which would be to find a version online for free. I’m 
sure there is a version out there that someone has uploaded for free. But don’t feel too bad about using it, because 
Bryce 7 used to have a 100% discount, and was bundled up with a bunch of other DAZ3D products that had the same 
discount. This discount is now discontinued, and Bryce 7 was replaced with “Bryce 7 Pro.”



The practicality of Bryce
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Bryce the Third
If you are up to spending money for Bryce 7, I would highly advise you do. Unless you plan to use Bryce 3 on proper 
hardware with no virtual machines, the program is near unusable. I won’t go into too much detail yet, but rotating in 
general, animating, the camera in general, and exporting your creations just becomes miserable. Maybe with the 
proper hardware, Bryce 3 is much more enjoyable, but I was glad to start using Bryce 7. Bryce 3 is still great, just 
rather limiting.

However, if you do want to use Bryce 3, there’s a very specific way to get it (or at least how I got it). This involves 
using a virtual machine to run the Bryce CD-ROM, considering that the setup doesn’t run on Windows 10. For this 
method, you’ll need:
● Bryce 3D for Windows 95/NT and Power Macintosh, found on Archive.org. Keep the Archive.org site open, 

because it contains the Serial Number.
● Virtualbox Virtual Machine
● Windows XP ISO file (Don’t be fooled! Despite saying “Windows 95,” the installer works on XP)



Getting Bryce 3
Firstly, you’ll want to install Virtualbox, and go through that whole process.

Once Virtualbox is installed, make a new virtual machine. You can call it whatever you want, but where VirtualBox 
asks for a file, open the Windows XP ISO file.

Once the virtual machine is made, open it. You’ll have to go through the Windows XP installation process, and once 
Windows XP finishes installing and restarting, you can begin adding Bryce 3.

In the window running Windows XP, click Devices > Optical Drives > Choose a Disk File > Add and add the Bryce 
ISO file. If it isn’t already, tick the checkbox for the Bryce ISO file from Devices > Optical Drives. You may need to 
restart the virtual machine.

Once you’ve restarted, turn the Virtual Machine back on and, in the file explorer in Windows XP, go to the My 
Computer folder and open the Bryce disk. Then, find the SETUP.exe file (There’s a lot of files named “SETUP,” so 
make sure to find the right one. One serial number input later, and you now have Bryce!



Unlocking Bryce 3
Now you have a virtual machine that can run Bryce 3. Great!

Now do yourself a massive favour. Mount the VHD (Virtual hard drive, a.k.a the folder with the extension .vhd), 
open whatever file explorer you are using and copy the whole drive onto your computer (or just keep the VHD 
mounted permanently).

If you go into this drive’s programs folder, you should see folders relating to Bryce 3, as well as the Bryce 3 
executable. You see, the installer for Bryce 3 is the only thing that isn’t Windows 10-and-above compatible. The 
actual installed application runs fine!

Better yet, running Bryce 3 on Windows 10 gets rid of the issues regarding rotation and animation, where the 
slightest mouse movement results in massive changes. Keep in mind, you will still be limited to .bmp files when 
exporting image renders, but as a free option, this way is the best way.



First Steps
Congratulations on getting Bryce! If you did just get it, I would recommend just placing random things in your scene. 
Water here, Sphere there, add a chrome texture to all of it, do whatever you want! Your scene is your world, do what 
you want in it. Your render doesn’t need to look fabulous, but it should be yours. You’ll look back at your progress 
and see these first renders. Below are some of my first renders. They aren’t the best (of course), and some of them 
even look rather bland and uninteresting. However, I’m still very glad I made them. They’re basically a relic of my 
skill, and it’s nice to see how far I’ve gone.



First (Professional) Steps

You’ve used Bryce, but you realise you’ve 
done as well as, well, a novice. You’ll 
occasionally press a button, but 
otherwise, this baby’s on autopilot. And 
that’s ok, because you’ll still probably 
make great art, but it doesn’t hurt to 
know about everything in Bryce! To 
start, simply open up Bryce. You’ll be 
met by this screen on the right.

(Note: This segment is very 
paragraph-heavy, and most pages are 
just a wall of text!)



Features: Window Bar
Starting with the very top bar (on the window, not in the Bryce editor), you’ll see 3 options. Well, 5, but only 3 of 
them are important for making renders. Starting with the File tab, which contains the usual “Open,” “New,” Saving, 
Importing and Exporting. It also has the “Render to disk” and “Render Animation,” which will export your render as 
an image file or video file respectively. The rest of the         
options relate to the actual Bryce editor, just like the Edit          
tab. The edit tab has the usual “Copy,” “Cut,” “Paste,” and             
they all work how you would expect. The rest of the options                                 
relate to selection objects and manipulating them in other          
ways. Finally is the Objects tab, which provide grouping,                                                                                                                                                       
and various other ways of manipulating objects and their                 
materials.



Features: Power in Editing

In the Edit tab of the Window Bar, you’ll find “Copy/Paste Matrix” and “Copy/Paste Material.” These are pretty self 
explanatory; Copying a matrix copies the scale, rotation, and position of an object, and applies it to whatever object 
you paste it to. Copying a material copies the appearance of the object and applies it to whatever object you paste it 
to.

The Replication tools are also self explanatory. It replicates your last move or addition in relation to your current 
selection. This means if you place a sphere, move it, and then replicate it, another sphere will appear in relation to 
the first. Multi-Replicate and Random Replicate do the same thing, but multiple times and with some variation.

Another useful feature is Duplicate, which will make a clone of your current selection.

Most of the features in the Edit and Object tabs are very useful, and you’ll be using them a lot. So, it’s best to know 
the shortcuts to them. The shortcuts are usually listed to the right of the option in the dropdown menu.



Features: Nano Preview and View Options
Just below of the File and Edit buttons, you will find a small preview showing what your scene looks like. When 
clicking on the small arrow below the preview, you can change settings regarding to the preview, such as What the 
Preview renders, the preview’s camera, the quality of the preview, and if the preview updates automatically.
The buttons to the left of the preview act as camera presets for a 
scene. The top button brings you back to the default camera, the 
same camera that every scene starts with. When you move the 
camera around, you can click any other button that isn’t highlighted 
to save the camera properties. Then, when you click on a highlighted 
button, the camera will revert back to the angle and position saved in 
that slot.

You can press Alt+Mouse1 to 
remove a camera state.



Features: Camera Controls
Below the Nano Preview is the heap of Camera Controls. Starting off with the white icon on 
the top left, which will switch your perspective (more on that on the next page). The circle on 
the top right allows you to switch between to and from Fly-Around mode, where you get a 
bird’s eye view of your scene spinning around. Below that is an island with a cube, a sphere, 
and a pyramid. It allows you to change the perspective of your scene, allowing you to see if 
from the top, side, bottom, and other angles. Below that are a bunch of arrows, which allow 
you to move your camera on 1 to 2 axis (you can move it one way or in two ways at the same 
time). The circles below that allow you to change the Banking and FOV. The circle with the 
arrows allows you to change the angle of the camera. All of the options under the grey arrows 
perform the same tasks as their respective controls.



Features: Director’s View and Camera’s View
But what really is the difference between the Director’s View and the Camera’s View? In short, the camera view is a lot 
more dynamic and has a lot more customizability than the director’s view. They both move with the same controls 
mentioned in the last slide, but the biggest difference has to do with animation. You simply can’t animate the 
director’s view. However, looking at the first image, next to the big sphere, there is the camera object. This object can 
be moved just like any other object in the viewport, such as the sphere. It can also be animated just like any other 
object, thus allowing the camera to move during an animation, something not possible with the director’s view.

Camera Object It can also be used for more novel ideas, like 
as seen on the left. The second image uses 
the director’s view and the third uses the 
camera view, which has been adjusted.

Note that, in the camera view, we can still 
see some light that was being projected to 
the ball, and a tree previously not visible can 
be seen.Viewport Render, Director’s View Render, Camera’s View



Features: Render Controls
Below the Camera Controls are the Render Controls. The leftmost button disables and enables object textures. The 
2nd button turns on Fast Render, which skips some of the render process, going straight to anti-aliasing after 
rendering the image once. The big button simply renders your scene. The 4th button resumes an escaped render, 
and the rightmost button clears the escaped, unfinished render, and 
starts a new one. 

When pressing the grey arrow, you’re able to change the render 
quality, optimisation, report settings, perspectives, and aspect ratios.

The option “Render Options…” allows you to change Anti-Aliasing 
mode, Preview render settings, post processing, optics, and light 
settings. The rest of the options are preferences found elsewhere in 
the render controls sub-menu.



Features: Render Options…
Below are a few renders of a metal ball over an ocean during the day. Each renders have different render settings.

Regular Render

Time: 00:38

Premium Render

Time: 03:05

Premium Render

All Premium Effects

DOF and Light Boosting

Time: 07:33



Features: Create Tab
The create tab is where you can add shapes and objects to your scene. Simply 
clicking the Create tab will bring up the menu below. This is where you’ll find 
primitive shapes, terrains, infinite plains, lights, and 2d objects. The DAZ logo on 
the right sends your scene to DAZ Studio. Some things are exclusive to Bryce 7 Pro.

Clicking the grey arrow next to the Create tab will bring up the Objects 
Menu on the right. This is where you will find more primitive shapes, 
boolean shapes (shapes with other shapes cutting into them), editable trees 
(more on that in the Tree section), objects exclusive to Bryce 7 Pro, some 
more primitives, household models, weird swirls, planets, animation paths, 
rocks, more trees, mountains, even more trees, objects featured in some 
Bryce tutorials (all beach themed), and various shrubs and flowers.



Features: Infinite Planes
Infinite planes are objects that appear as large planes on the viewport, but appear infinitely large when rendered. 
There are three types of infinite planes; Water, Cloud, and Ground. As far as I’m aware, the only difference between 
them is what material they are created with, where they are created, and their starting scale. To prove it, I rendered 
all three using the sky “Peach Haze” and the material “Mermaid’s Hair.” They’re basically identical, but the ground 
plane render’s material was rotated slightly. They all took 37 seconds to render, and they even had the same file size! 

Oh, and the reason why there are only 2 renders is because the Water and Cloud renders were exactly the same.

The background is a little render 
showing off the infinite planes.

Sometimes, a Water/Ground plane 
and a Cloud plane is all you need to 
make a visually appealing image. 
Although, if you do use the cloud 
plane, it’s best to find a sky without 
clouds, or edit them in the sky lab.



Features: Infinity Cubed
Usually, an infinite plane works fine, but if you want more depth (say you are making a sky with clouds, and don’t 
want to use a flat plane or the sky lab), you can use a volumetric slab! Hold one of the three plane objects on the 
create tab, and you should see a menu asking for either a Surface or a Volume. Click Volume, and a cuboid should 
appear.

On the left, you can see a volumetric slab being used for 
clouds below the scene.

Despite the slab being infinite, both the width and depths 
can affect the slab in meaningful ways.

Volumetric slabs are (in my opinion) best used with cloud 
volumes (particularly the ones in Atmospherics > 
Planes-Volume and Cosmic-Volume). There aren’t any 
water volumetrics and the volumetrics found in Misc > 
Volumetrics can look good, but take long to render.



Features: Terrain
Bryce is known for its superb fractal terrain abilities. That’s why the 
program is called Bryce. It’s in reference to the Bryce Canyon in Utah.

Back on topic, Terrain is randomly generated, so each time you click 
the terrain button, you’ll get a brand new mountain. This is useful for 
making backdrops for a scene. 

However, Terrain on its own is pretty bare bones. This is where the 
Terrain Editor comes in. When selecting a terrain object, click the [E] 
button (Edit) that appears beside it, below the [M] button (Material 
Lab) and above the [↓] button (Landing). This should bring you to the 
terrain editor.

In this editor, you can paint the height of the mountain, apply various 
effect and edits to the canvas, and even animate it.



Features: Messing with the Terrain Editor
You can also import images to use as heightmaps, although the image is resized to a 1:1 aspect ratio. Any image put 
in is turned greyscale, and then is treated like a regular terrain canvas. Of course, wackiness ensues.

Anchorman’s Ron Burgundy in 
David Brinnen’s Threaded Bar.

The Brazilian Entertainer Ricardo 
Milos, embodied in a flower field. 
Only complaint; looks demonic.

Is the Earth round 
or flat? Both wrong! 
It’s actually Mario 
and Bowser shaped.



Features: Trees, Rocks, and Lattices
As well as the Terrain object, the other random objects are the Trees, 
Rocks, and Lattices. A tree is… well… a tree. Sometimes it’ll have 
different coloured leaves. A rock is… well… a rock. The rocks created 
usually range from rough to smooth, and there are options to smooth 
rocks out in their edit menu. Finally are Lattices. These are basically 2 
Terrain objects directly on top of each other. They have a similar editor 
to Terrain objects, but when Alt Clicking on the canvas for long 
enough, the spot will go from black to red. The red space has no height, 
and isn’t rendered.

Trees have their own editor. It allows you to change settings about the 
tree’s trunk, branches, tree shape/type, and foliage. This allows you to 
produce certain other trees, like palm trees.



Features: Metaballs
Metaballs are pretty magical. Imagine you wanted to make a bean in Bryce 3. Easy, right? Well, no. Bryce 3, nor 
Bryce 7, has a bean/capsule object (well, it does, but it is a mesh, so it isn’t smooth like spheres. So, you would either 
have to make a bean amalgamation out of 2 spheres and a cylinder, or import a bean model. Not with metaballs! 
Metaballs act just like spheres alone, but when close enough to another metaball, the two will join, producing 
geometry linking the two balls. The two balls’ material will also merge. A good example is this “Windows Metaball,” 
which features 4 Metaballs. Each are linked by a small section, and those small sections fade between the two 
materials.

However, just because you can metaball, doesn’t 
mean you should metaball. Ignoring the prone 
crashes provided by the metaballs, they are capable 
of making abominable horrors just as easily as 
making the perfect object.

Regardless, the power of the metaballs is 
only accessible in Bryce 7. Bryce 3 doesn’t 
have metaballs.



Features: Primitives
There are 6 primitive objects. They are spheres, tori, cylinders, cubes, pyramids, and cones.

Only the torus is editable, allowing you to change the torus’ radius. However, this radius is capped a lot higher than 
512, allowing you to make 2 circles inside of each other.

There are also 3 2D primitives, being the 2D Face, Disk, and Picture Objects. 

The Face and Disk act like flat planes, being a square and circle respectively. 

Mario and Bowser looking at a photo of 
themselves. The image was not added in 
post. It is part of the scene!

The Picture Object is similar to the Face Object, but you can import images 
to use as a material. When creating a Picture Object, you’ll be brought to a 
menu with three big images and a grid of smaller images. To add images, 
just press one of three Load buttons, or click on a blank space on the 
smaller grid.

With the image editor, you can also make images with transparent 
backgrounds like the one seen on the right of this page. Once you have your 
transparent image, go to the Materials Lab and set all settings into the 
corresponding slot (Usually the A slot, more on this later).



Features: Lights
Oops! Looks like someone turned off the lights on this page. Not to worry, we’ll just add our own!

These are the 5 light sources (4 in Bryce3. The Round Parallel Light is missing).  The first of 
these is a Radial light. It lights up all around the light object, rather than just towards a 
specific direction. A good way to demonstrate this is with a scene like the one on the bottom 
left. It isn’t the best render, but it will demonstrate how light affects a relatively normal scene.

No lighting Radial lighting

As we can see, the radial light lights up the whole scene, providing 
light to multiple areas rather than just one or two. This is great to 
use if your scene is just a bit dark, and you want the whole room to 
be a bit brighter.

The other light sources, being the Spotlight, Square Spotlight, 
Round Parallel, and Parallel lights, all focus the light on one or two 
areas.



Features: In the Spotlight
We can use our little foliage example to show the two spotlights as 
well. In the two renders to the right, we can see that not every angle 
is lit up like the radial light did. Each spotlight has been raised up, so 
the light covers the whole scene.

Spotlight Square Spotlight

Parallel (Left) and Round Parallel (Right)

For the parallel lights, we 
can’t use the same scene to 
great effect, so, on the left, is a 
room with a floor and ceiling.

The parallel lights in the viewport are roughly in the middle of the floor and 
ceiling, yet they project a spotlight that hits both surfaces.

Apart from the object that represents them on the viewport, they are identical to 
two spotlights parallel to each other.



Features: Work the Light
Don’t like the light? Well, just like most things mentioned already, all light objects have editable properties.

In the Light Lab, you can change the type of light, shadow properties, 
render options, strength, colour (with gradients too!), the image 
casted by the light, and other settings.

You can see them all in action in the fever dream render below.



Features: 24 Carat Light Source
But what about the lights exclusive to Bryce 7 Pro? Well, don’t worry, because 
you’re not missing much. The distant light, being the Circle with multiple circles 
around its circumference, acts as a super version of the radial light. It lights up 
your entire scene, not just objects in range of the light. Moving the object does 
nothing. 

The next two objects are basically the same as their free counterparts; the Round Parallel and Parallel lights. They 
look the same, they have the same name in the editor and same model in the viewport. The only difference is that the 
two Pro Parallel objects can have the “Infinite Width” and “Directional Control” properties, making them identical to 
the distant light. The Sphere Dome and Cube Dome lights act as an alternative to the radial light. Changing the 
properties allows you to have light within or outside of a dome (seen in the viewport).

The last two are fill lights. They’re quite complicated, but simply, if you make a big cube, put a 
cube fill light inside of the cube, set the light’s colour to a gradient that goes from black to white, 
put a tree inside the cube, move the camera inside the big cube, and render, you’ll get something 
like the image to the right. The fill lights put light inside objects, illuminating the objects within 
those objects.



Features: Objects Menu
Again, if you press or hold the grey arrow next to the Create 
tab, you’ll see the Objects Menu. This menu provides many 
prefabs for you to use.

However, you can also Add prefabs to this list. To do this, 
select an object or group, then go to the Objects menu and 
press Add. You’ll see a prompt asking for a name and 
description for your prefab. Once you fill that out, your prefab 
is now saved to the selected Category. As well as this, you can 
delete prefabs, as well as add and delete categories using the + 
and - buttons at the bottom.

You can also import and export Bryce Prefabs. This allows you 
to export or import a .obp file. 

This is not how you import 3d models! That is done by 
going to File > Import Object.



Features: Edit Tab
The edit tab is where you can manipulate shapes and objects in your scene. This 
include scaling, rotating, transforming, aligning, and randomizing. It also provides a 
shortcut to the Material lab and Terrain Editor. The two-way arrow at the top-right is 
a way to transform your current selection into any of the objects presented there.

However, the Holy Grail 
of the Edit menu is the 
Materials menu. In the 
same vein as the objects

menu, clicking the grey arrow next to the Edit tab will bring up a whole gallery of 
materials. There, you can pick a material to add to your model. Bryce 3 has a much 
smaller range of materials, but Bryce 7 has multiple categories of materials like 
“Metals” and “Stones,” each of which has their own sub-categories like “Industrial 
Metals” and “Marble” respectively. Similarly to the objects menu, you can also add 
and delete categories, as well as add, delete, import and export material prefabs. 
Now, you’ll be importing .mat and .shd files. 



Features: Transforming Objects
The Materials Lab will be brought up shortly, but for now, let’s stick to 
something a bit more basic: Transformation tools! More specifically, 
Transforming, Scaling, and Rotating an object. All three of these actions 
can be done without using the edit menu. 

To transform, simply drag on the object around the viewport. If you click one of the several black squares, you will 
instead scale the object. The text that appears when hovering over a black square tells you what axis the object will be 
scaled on. Dragging on a black square while holding the Control key will instead rotate the object. The object will still be 
rotated in the black square’s respective axis.

Holding the Shift key will scale or rotate the object in large increments, and holding the Alt key will rotate a lot slower 
with higher precision. Holding Alt while scaling will scale the object while keeping its centre position the same. Clicking 
on a black cube while holding Control and Alt will bring the object back to its default scale. To rotate with higher 
precision, you need to first drag the square while holding Control, and then start holding Alt as well.



Features: Advanced Basics
The basic transform, rotate, and scale options are usable on the viewport and with the icons in the Edit tab. However, 
there are grey arrows next to each icon, and as you would expect by now, these arrows provide extra transform options.

Each sub-option allows you to transform, rotate, and scale in reference to the whole world (Default), the object alone, or 
the camera. These are pretty useful, but they’re mainly a great asset for scaling. Scaling a single object in reference to the 
world usually causes ugly warping if the object is rotated. However, when scaling in reference to the object, scaling is as 
easy as it should be, and the weird warping is nowhere to be seen. As well as this, each tool has a sub-option labelled 
“Un-transform/scale/rotate” respectively, which resets its respective values to their defaults. There is also a “3D 
Transformations…” option, which allows you to set values corresponding to the object’s position in relation to the centre 
of the location of its creation, as well as the rotation and scale.

The scale sub-options contain 3 extra options, each flipping the object on either the X, Y, or Z axis. This is useful because, 
unlike other 3d modelling programs, you can’t negatively scale an object, so making an axis smaller won’t eventually flip 
the object, it’ll just make that axis really small.

Long story short, the flip tools are much appreciated due to the lack of alternatives.



The align tool is somewhat useful, but only in tandem with the randomize tool. 
The randomize tool change spread out a group of objects, as well as randomly 
changing their rotation and scale. The randomize tool can also spread out objects 
in a 2d or 3d area (2d as in no objects change their Y position). 

Features: Chaos and Order (Randomize and Align)
Next is the Align and Randomize tools. Simply, the Align tool allows you to line up a group of selected objects to a 
particular axis. The Randomize tool allows you to randomize the position, rotation and scale of an object or group of 
objects. Starting to understand why this page is called Chaos and Order?

Obviously, it’s still completely 
random and only partly in 
your control. Too much 
randomization can have… 
some interesting results…



Features: Materials Lab
The Materials Lab is where you can modify object materials. Naturally, it’s visited a lot. There 
are 4 types of material editors in Bryce: The Material Editor; one for Surfaces and one for 
Volumes, a Picture Editor (which was previously mentioned), and the Deep Texture Editor.



Features: Materialistic Matters

Surfaces have all of the properties listed on the right. Each are editable 
and can be sourced from textures (the images on the far right. When 
there are no textures, the letters A through D are present instead).

Each column of dots corresponds to a texture. Objects don’t need 
textures to have a material, but no blue dots will be present on the four 
columns. If you click on an empty dot on a row that doesn’t have a 
texture, a random texture will fill in that slot.

The grey arrow next to the material preview opens the Materials Library. The grey arrow below the preview lets you 
change the preview, like changing what object the material is previewed on. The sideways button to the left of Specular 
Halo randomizes the material’s parameters and textures, and the sideways button below that one reverts the material 
to the default grey material. The grey arrow at the top right, next to the textures, lets you change how the material is 
rendered, such as making the material additive, or fuzzy, or a light.



Features: Scratching the Surface

To sum up what each value does, the first 6 control the colour of the 
material. Diffuse and Ambient are the main ones, as they control the 
colour of the object in the most abundant manner.

The middle 7 are sort of miscellaneous. It has features such as metalicacy, 
and the ability to add a bump to the material, adding some extra depth. 
The Diffusion and Ambience values control how intense the respective 
colour is.

The last 3 all handle with reflections and transparency. Simply put, 
Transparency is how transparent the object is, Reflection is how 
reflective the object is, and Refraction controls how the object behaves 
with light. It can cause reflection without having any reflection set on the 
material!



Features: The Material’s Accomplice
As mentioned, the boxes with 3 images in each are textures. They can add more depth to a 
material. To add one, click on an empty slot in the textures column. Then, one of the boxes 
on the right should appear. These boxes have extra buttons and values to modify.

The green button on the top-left brings up Transformation Tools, where you can Move, 
Rotate, and Scale the texture. This is useful for animating, as it allows for cool effects like 
an infinite plane with moving water.

The red button on the top-left brings up the Deep Texture Editor. More on that in a bit.

The (T) and (P) buttons let you swap between a procedural and image texture. The 
top-right arrow brings up a list of textures. If you press the button while holding Shift, the 
textures are displayed in a library.

The bottom-right arrow lets you change how the texture is mapped to the object. This has a 
variety of modes, such as World Space, Object Space, Panametric, Spherical, Cylindrical, 
Random, and more.



Features: Making Volumes

To swap from Surface to Volume, click on the big green button with the 
rock or cloud in it.

Volumes are similar to surfaces except for, of course, their depth. Despite 
this, most of the settings are the same, except for the bottom 4. All of 
these are pretty self explanatory, and they all change the shape of the 
volume. Quality/Speed might be confusing, but that refers to the speed of 
the render, or how long it takes to render the volume. So more quality 
will result in a slower render. This is why Quality is represented with a 
turtle.

The grey arrow on the top right has slightly different settings, allowing 
you to change how the volume is shaded.



Features: In the Deep End (of textures)
If you don’t like your textures, or want to modify them, then simply go to 
the Deep Texture Editor. You can find it by pressing the red button on a 
texture, as well as by going to the Edit tab, clicking the grey arrow under 
Materials, and selecting “Edit 3D Solid Textures.”

The Deep Texture Editor, or DTE as it will be referred to, has 4 
component boxes, one of which is the combination. In short, textures 
combine in specific ways and pass through specific filters to generate an 
output - the combination - which becomes the texture for a material.

In Bryce, the material hierarchy goes like this:

Materials > Textures > Images
Materials are made of Textures, which are images combined and filtered 
through the DTE.



Features: Component Magic

The components have a lot of different buttons, each with a unique function.  The 
top-left button lets you add noise to an image. The buttons on the Noise prompt 
control which component is being modified.  The bronze sideways button resets the 
component. The top right button filters the component. You can change the filter by 
clicking on the black bar with the filter on it (usually “None”).

The bottom right button lets you adjust the phase of the component. The sideways 
button on the bottom right randomizes the component. Doing this to the combination 
randomizes all 4 components. The C A and B buttons are toggles for if the 
components Colour, Alpha Channel, or Bump Map should be utilized.

The three colours are the colours of the component. The arrow underneath the 
colours controls what the colours represent and how they are used.



Features: Deep Offshoots
The numbered squares controls how many components there are (1 + the combination, etc.). The plane, cube, and sphere 
control what each components’ image is shown on. It defaults to showing the image flat, but it can also be seen on a cube 
and a sphere.

The arrows between components is how the component is used in relation to the others. Clicking on the arrow allows you 
to change this.

Also, by Alt+Clicking on a component’s image, you can get a full-screen render of it.



Features: Meshes and Booleans
You can make changes to your object’s geometry using booleans in the object attributes menu. Booleans in Bryce are 
Positive, Negative, Intersect, and Neutral. Positive objects are objects subjected to change from Negative and Intersect 
objects. Otherwise, they look identical to neutral objects (unless converted into a mesh, which may cause them to look 
slightly different. Negative objects are invisible. When a positive and negative object are grouped together, any part 
where the negative object intersects with the positive object will also appear invisible.

Note: A positive object must be present in the group for the negative objects to be invisible. Otherwise, they will be visible 
and very much not negative.

Intersect objects are similar to Negative objects. In fact, they’re near identical, and most of the properties mentioned 
above apply to both types of objects. However, when an intersect object intersects a positive object, only the part where 
they intersect will be visible, and the object will inherit both objects materials on their respective sides. Neutral objects 
are normal objects that aren’t subject to any of the effects of Negative and Intersect objects, and they can’t be converted 
into a mesh. 

The top right graphic shows booleans in action. The last one, Intersect, have the materials of the two cylinders swapped.



Features: Origin Handle
Each object has an Origin Handle, which is the point where the object rotates. You might not have known, because the 
Origin Handle is initially hidden. To show your current selection’s Origin Handle, go to its attributes menu and enable 
Show Origin Handle. This will make a little green dot appear, which you can move around.

Why is this important? Well, mainly for animation, which is touched on later. Also, objects linked to one another will 
change where they’re linked to when the origin handle moves, due to the object being linked in relation to the origin of 
the object.

     The “Tennis Origin!!”



Features: Linking and Tracking
When selecting an object, options will appear next to it. The button with three 
squares on it (left icon on the right) is the Linking Button. Holding on to it 
will bring up a line, and hovering over another object will link your selection 
to that object. Linked objects can move independently to the object they are 
linked to, but when the parent object (the object being linked to) moves, 
rotates, or scales, so will its children (objects linked to a parent). Objects can 
only have one parent, but can have as many children as you want.

The button with a squares and lines around its edges (right icon on the right) 
is the tracking object. This simply makes an object face its parent (the object, 
not the origin handle). Again, a object can only track one other, but can be 
tracked by more than one.



Features: Instancing Lab
If you need to spread a particular object across the surface of another object, while adding slight variations to each 
object, then the Instancing Lab is your go-to stop for exactly that!

The Instancing Lab has two tabs. The painter is where you can place 
down a mass amounts of objects at once, and change settings regarding 
how they are spread out. First, you need a brush, which can be created 
on the Brush Editor menu. This allows you to select one or more objects 
to be used as a brush, and properties regarding variance.

Although a mass 
amount of objects 
sounds fun (and is 
fun), your render 
time will skyrocket if 
the Instancing Lab 
isn’t used sparingly!



Features: Other Buttons
The grey square button below the [A] button is the family button. You can change the 
family of the object by clicking one of the colours that appear when pressing the 
button. Families change the colour of the object’s hologram on the editor, and you can 
select every member of a family using the selection bar at the bottom right.

The down arrow button grounds the object, which changes its Y position to a specific 
value “on the ground.” The actual Y value won’t be constant, because different sized 
objects will have different Y values due to their Origin Handles. However, all objects 
will be touching the ground, and won’t be below it, the ground being Y level 0.

The [C] button only appears when selecting a group containing a Positive object. 
When pressed, the group is converted into one Neutral mesh. This can be helpful when 
dealing with a lot of booleans, as it can prevent group clutter.

However, groups converted to meshes aren’t rendered with math, like spheres, so 
some object faces will be visible; the object won’t be perfectly smooth, although the 
edit tab (the [E] button) allows you to change the smoothness of a mesh.

Once a group is a mesh, its 
individual objects can not be 
individually moved.



Features: Mass Selection (Selecting All Objects)
If you want to select, say, all lattices in your scene, then look no further than the line-up of objects in the bottom right!

Clicking any of these buttons will select every object in your scene that, well, is that object.

Note: The water plane is actually selecting Volumetric Slabs. The weird gradient to the far right is selecting Families; a 
drop-down, or rather drop-up, will appear with every family in your scene. Selecting a family will select every member 
of that family. 

Selection via this method works exactly the same as selecting an object in the viewport. Shift to add or remove from 
your selection, Ctrl to select a specific object out of that group. The only difference is, instead of referencing every 
object your mouse is over, it references every object of that type.

Of course, Ctrl + A also selects every object in your scene. However, this includes every type of object, as well as the 
camera, so it’s sort of a nuclear option unless you don’t have many objects to begin with.



Features: My Bryce (The Customization Options)
The customization options, conveniently and accurates to the right of this page, are less customization and more 
random stuff that doesn’t fit into the Create and Edit tabs. Most of these are pretty minor, so this page will only have 
a summary.

Demo Pen lets you draw on your desktop (yes, desktop, not just the viewport or editor). Spray Rendering lets you 
draw your scene (your scene renders on the blobs created with the tool). The expand tool changes the editor from 
being the size of your computer screen to the size of the scene’s resolution. Bryce 7 doesn’t seem to change (or even 
let you press the button), but the proper effects occur in Bryce 3. Background Paper lets you change the background 
of the viewport, specifically the texture and colour. Nano Editor enables and disables the nano editor, a small view 
of your render that pops up when rotating. The main viewport will not rotate if this is enabled.

Plop Render lets you drag a space on the render screen to render only that part. The whole render doesn’t need to be 
finished for Plop Render to be used, although rendering has to pause. Depth cue changes how transparent objects 
become when they get far away from the camera. Shadows enables and disables object shadows in the viewport. 
Underground enables and disables the green line in the viewport which shows the horizon. It also hides objects 
underneath the horizon in the editor, so it acts like a floor.



Features: The Rest of “The Rest of the Features”

The Resolution button isn’t what it seems. In short, it controls how objects appear in the viewport when they are 
Static, Selected, or in Motion. This is helpful for cluttered scenes that lag a lot. Auto LOD, or Auto Level-Of-Detail, 
will automatically change the resolution of objects if the scene becomes too laggy.

The Zoom In, Zoom Out, and Drag controls are self-explanatory. They zoom and drag the camera view in a 2d way, 
being that the camera doesn’t move unless dragged, and when dragged, it only moves on two axis.

Finally, the Display Modes. The three default display modes (the ones toggled between by simply pressing the 
wireframe cube) change your scene from showing a wireframe version of your scene, the last render done, and both 
on top of each other.

The other Display Modes render your scene in a low quality, which allows you to see the textures and a rough look of 
your scene. It’s comparable to Blender’s Material View mode. There are also options that show shading instead of 
textures.



Features: Sky and Fog
The next few pages regard the Sky and Fog tab, the last tab in the editor! It handles skies, and fog, but mainly skies. 
Honestly, I’m not really sure why it’s called “Sky and Fog” when there is only 4 settings regarding fog, or 8 if you 
count haze as fog.

Pressing the grey arrow next to the Sky and Fog tab brings up the 
Skies menu (or… the “Sky&Fog” menu…). This contains a heap of 
skies for you to use. Some are much better than others (The Fantasy 
tab is home to a few stinkers, although that’s kind of the point), but 
most of them are great.

Don’t feel discouraged from using these! Some skies like Autumn 
Morning, Blue Jeans 3, and Realism Achieved are really good!

However, if you want your own skies, you’ll need to take a trip to the 
Sky Lab.

Background is “Autumn Morning”



Features: The Surface
On the Sky and Fog tab, a couple of options appear. 

Sky Mode changes the sky’s brightness and colour. You can also turn the sky into a flat colour. When selecting 
“Custom Sky,” the colours, in order, change the Sun Glow Colour, Sky Colour, and Horizon Colour, which are all 
exactly what they sound like.

Shadow Intensity and Colour changes the opacity and colour of shadows. Fog Height (which is actually Fog Density 
and Fog Thickness) and Fog colour change the intensity and colour of the fog. Haze Intensity and Colour changes 
the colour and intensity of the haze, which is the part of the sky at the horizon.

Cloud Height changes how high the clouds are, effectively scaling them up or down. Sky Dome Colour changes the 
colour of the objects of your scene, applying a hue. Cloud Coverage and Cloud Colour change the density and colour 
of the clouds.

The weird blue and white graph is the controls for the frequency and amplitude of  the clouds, or the amount and 
density.

Background is “Blue Jeans 3”



Features: Still up in the Clouds
But wait! There’s more!

The little white square changes the Sun Colour, which adds an extra tint to objects in the scene. When it’s white, no 
extra tint is added and every object retains its regular colour. This is a sort of dumbed down summary of what a 
change in Sun Colour does.

The big sphere-like option controls the position of the sun. By extension, this changes where shadows appear. 
Moving the circle too much will switch the sky from Day to Night and vice versa. This changes the sky colour and 
brightness of the sky and scene. Changing from Day to Night can also be done by pressing the Sun icon (the yellow 
circle), which turns into a Moon if the sky is in Night mode.

The slots on the side of the Sun Control acts the same as it does with the Camera. It allows you to save and load 
skies, and reset the sky by pressing the top green button.

The group of dots next to the Sun icon randomizes every sky property, effectively giving you a random sky. Most of 
these are pretty ugly due to their random nature, but some can look good!

Background is “Realism Achieved”



Features: Taming the Sun
If you need more precision and perspective when positioning the sun, there is an easier 
method. 

Background is the Default Bryce Sky with the sun moved.

Double click on the Sun Control while holding 
Ctrl+Alt. Then, Ctrl+Alt click anywhere on your scene, 
and the sun will be positioned there.

If done correctly, a small 8-pointed star should appear 
on your scene. This is where the sun is.

This can help greatly, as it provides much more 
perspective and context than entering values or 
dragging the Sun Control.



Features: Reaching into the Heavens
But wait! There’s still more!

The grey arrow below the sky save states brings up more options. These each have different effects, 
so the menu acts as a sort of “More Options” menu.

Auto Update will render your scene everytime you make a change to the sky. It’s useful when slightly 
tweaking skies. Link Sun to View is a toggle, and does exactly what it says. No matter what direction 
your camera is facing, the lighting will be exactly the same.

Stratus and Cumulus Clouds are simply types of cloud layers you can enable or disable. With both 
on, both layers will be present in the sky.

Spherical changes the way the sky is rendered, specifically its position and wrapping.

Reset Sky resets the sky to the default Bryce 7 sky.

And Sky Lab…

Background was randomly generated



Features: Sky Lab

Next is the Sky Lab, a.k.a everything just mentioned and 
more.

There is a lot in the Sky Lab, so most of this will be rough 
descriptions, especially with topics already mentioned.

To open the Sky Lab, press the Cloud and Rainbow button 
next to the Randomize button. You can also press Ctrl+K.

The sky lab features 4 subcategories, the first of which 
being Sun & Moon, which deals with the Sun, Moon, Sky 
colour, Brightness (or rather Sun Intensity), Shadows, 
and other Sky Effects like Comets and Halo Rings.

Background is “Wisp O’ the Will”



Features: Sun, Moon, Shadows etc.
In this menu, some extra features are present. The first is 
Celestial. This controls the position and angle of Stars, 
Comets. Moon Phase also affects Stars and Comets, but 
also changes the appearance of the moon.

Sun/Moon Visible allows the removal of the sun or moon 
(whichever is present), and also lets you change their 
opacity and glow. Sun/Moon Size lets you change the size 
of the sun or moon. Sun/Moon Shadows and Shadow 
Softness lets you enable or disable shadows, their opacity, 
and their softness.

Sun Intensity changes the brightness of the scene. Its 
settings are similar to that of a light object.

Ambient and Sky Dome Colours change the Diffuse and 
Ambient Colours of object in scene.

Background is “Autumn Sunset”



Features: Halos, Comets, and Stars
If you want more pizzazz to your night sky, there’s always Stars, Comets, and 
Halo Rings! You’ll need the Celestial option to be enabled for the first 2 to 
appear.

Stars appear as little frantic dots in the sky.  You can change how many there 
are and how bright they are.

Comets appear as coloured cones in the sky. You can also change how many 
there are and their opacity.

Background is “Star Glow” with a random Celestial Field and increased amount of comets and stars.

Halo Rings add a big ring around the sun or moon. You can change their size, opacity, and add another ring.

These are all great additions to a night sky, but they’re also a bit finicky. Sometimes, stars and (especially) comets 
won’t appear in the sky, and all effects are only visible in a dark sky, and are barely visible in a bright sky.

However, when the stars align, you can make a great scene with a spacey, even sci-fi feel!



Features: Cloud Cover

The second subcategory is Cloud Cover, which deals with clouds.

As a small note, Stratus and Cumulus are simply different classifications for 
clouds. Stratus clouds appear more like a flat sheet, while Cumulus has more 
mass and density, in that it isn’t flat. But I’m not cloud expert.

When looking at the menu to the left, you can see the Stratus cloud controls are 
the exact same as the Cumulus, so each control will only be mentioned once.

Also, the grey and white graph from before that controls the frequency and 
amplitude of the clouds controls both Stratus and Cumulus clouds.

Apart from appearance, the only difference between Stratus and Cumulus is 
how certain settings change values (such as changing the amplitude and 
frequency a different amount for either), and that the setting Cumulus Cloud 
Colour has no effect on Stratus clouds.

Background is “Texas Sky”



Features: Cloud Cover
Starting off, we have the orange button next to “Stratus” and “Cumulus.” This enables and disables the clouds of that 
type. The image below both the word and orange button acts as a texture to the clouds, and it tells the clouds how to 
generate. The two white (+) and (-) symbols distort the texture, and the two blue (+) and (-) symbols zoom the texture 
in and out. Edit brings you to the Deep Texture Editor, where you can edit the cloud texture, and Reset reverts the 
texture to what it was before it was edited in the Deep Texture Editor. The sliders are self explanatory.

Background is “Storm Rising 02”

Cast Shadows controls if the clouds should produce a shadow. Link 
Clouds to View makes the clouds appear the same, no matter the 
camera angle. Fixed Cloudplane prevents the clouds from changing 
appearance when the camera is higher. Spherical clouds, as mentioned, 
gives the clouds a spherical, puffier look.

The circle with -/+ X and Z, and both values under Cloud Motion 
controls how the cloud should act when animated. The circle controls 
its direction, and the speed and turbulence control… well… you get it.



Features: Atmosphere
The third subcategory is Atmosphere, which deals with Fog, Haze, and 
atmosphere (crazy, right?).

The Fog and Haze settings are the same as before, but now there’s also a 
button to disable and enable them. Colour Perspective fills the sky with 
colour. When all 3 colours (RGB) are at 100, the sky is completely opaque 
with no features, and will become the colour of the haze.

Rainbow adds a rainbow! You can change the radius and opacity of them, and 
even add a double rainbow. Depending on the sky, they may appear faintly or 
out of camera.

Background is “Golden Day”

Blend with Sun changes the brightness of the sky to change the further it is to the Sun. The sky will appear as a 
gradient, with different brightnesses depending on distance from the sun. There are options to change the colour and 
luminance of the effect, as well as making haze and fog blend as well. Volumetric World makes lights appear as light 
sources and rays.



Features: Image-Based Lighting (HDRIs)
HDRIs can be used in Bryce if you want a really realistic sky. Of course, you need 
to make or download HDRIs before-hand. Websites like PolyHaven have free 
HDRIs for download.

In short, all of these objects relate to the current HDRI being used. They’re all 
pretty self explanatory, but some aren’t so much.

HDRI Effect just changes the intensity of light, similar to the intensity setting on 
a light object. It only affects objects.

The Use Sky button next to Sky Dome only allows you to create HDRIs using the 
current sky.

Background is PolyHaven’s “Table Mountain 1 (Pure Sky)” HDRI

HDRIs aren’t a breeze, nor are they as easy to manage (or obtain) as regular Bryce skies. However, you can achieve 
stunning renders when HDRIs are properly utilized.



Features: Skylab’s Viewing Quarters
A viewing section will always be present when in the Sky Lab. It contains a small preview 
of your scene, as well as some controls previously mentioned.

The grey arrow on the top-right of the preview opens the Sky&Fog menu, allowing you to 
switch to other skies in the library.

The grey arrow on the bottom-right lets you control the preview. You can change the 
preview to render your actual scene, rather than your sky and a sphere only. There are 
also options to change render quality, as well as an option to add ground to the render.

And that’s everything the Sky Lab 
has to offer! The only thing left is 
to open Bryce, go to the Sky Lab 
and tinker around to produce a 
beautiful skyscape!



Features: Animating in Bryce

Bryce is capable of animation. It’s pretty primitive, and doesn’t have anything like Rigging or a Motion Editor, at 
least not in the traditional sense. Animation in Bryce is done with Keyframes, or set values at a specific time. Bryce 
with linearly animate your object from one keyframe to another, but, of course, we can change that using Bryce’s 
Advanced Motion Lab. You can also use Paths, which are premade tracks that dictate the movement of an object, and 
you can create your own tracks.

To start, let’s change the bottom Mass Selection palette to the Animation palette. Click the Palette Toggle at the very 
bottom-right of the editor. The buttons at the bottom should appear. The 6 empty slots are time saves. Click them to 
instantly travel to a certain time. The film reel is the Animation Preview, which renders each frame in low quality for 
a preview. The 6 timescale controls do what they look like. The + and - beside the key are to add or remove a 
keyframe. Holding down on either will let you add or remove a specific timeline, like Position only etc. The key 
changes if there is a keyframe on the current frame. The sine graph brings you to the Advanced Motion Lab. The grey 
arrow lets you change the tickers on the timeline, enable autokey, and lets you change other time-related things.



Features: The Key (and path!) to Animation

To see the effects of animation, put a random object on the scene and add a keyframe. Then scroll through the 
timeline using the bar at the bottom of the editor. Now, move the keyframed object in away way you like. Scale it, 
rotate it, whatever you want. Then keyframe again. Now skip back to the start and press play. Your object should be 
moving!

That’s the absolute basics of animation in Bryce; two keyframes at different times will transition from one to another 
over a period of time dictated by the distance between the keyframes.

The same idea applies to Paths, but with a bit more setup. Link an object to a track, and its position will be locked to 
the path (it can not move to a spot off the path). Then do the exact same thing as above. The object should go from 
one position to another, using only the path.

If you want to make your own path, you can select an animated object and go to Edit > Create Path or press Alt+P.



Features: Advanced Motion Lab

However, if you want to have advanced motions, you’ll 
need to use the motion lab. This is where you can 
change the position of keyframes, duplicate keyframes, 
and change how an object should transition from one 
keyframe to another.

It also has some camera controls. The button below the 
camera icon is to toggle between Director’s View and 
Camera View. The + and - are to increase and decrease 
FOV. The last two icons are to reset the camera and to 
adjust the camera angle. All of these changes only 
affect the preview. The actual camera won’t be 
modified.



Features: Timelines and Keyframes

The bottom half of the AML shows the object and their 
timelines. The timelines will only be visible if there are 
keyframes on them, and if the parent object is 
collapsed. Objects can be hidden in the preview by 
using the eye next to their name.

Keyframes are represented by a bright line on the timeline. The numbers on the number line above them show 
which frame the keyframe is on. The grey circles on the numberline are the start and end of the Working Range, 
which is the part of your animation that is previewed in the Animation Preview.

You can drag to select keyframes, and press Backspace to delete keyframes. Press Ctrl while dragging on a keyframe 
to duplicate it. While multiple keyframes are selected, holding Alt while dragging with only drag one keyframe.



Features: Motion Graph
The top-left corner has the Motion Graph, which controls how one 
keyframe should transition to another. How the graph works is as 
such.

The line moving on the x-axis is the time in seconds, and the one 
moving on the y-axis is the entire animation, being the first keyframe 
of the timeline to the last. The current time is where the two purple 
lines intersect. The grey dashed lines represent the keyframes.

You can change the graph by selecting one of the presets, or by adding more points (the green squares) to the line. To 
do this, click anywhere on the line. You can Ctrl+Click on a point to delete it. Shift+Clicking on a point changes how it 
eases to another point. Alt-Clicking anywhere on the graph shows a linear version of the line.

You can zoom in by dragging anywhere on the graph. Shift-Clicking will zoom in or out until the graph is reset to its 
normal position.



Features: Bryce’s Secrets

You know how I mentioned that Bryce 3 has various object presets, and Bryce 7 doesn’t? Well, that’s not true!

Click on any primitive while holding Ctrl or Shift, and you’ll get an alternate version of it! This goes for nearly 
everything in Bryce; hold Alt, Shift, or Ctrl to get something different. For example, the menu in the Edit tab that lets 
you replace your selection with a specific object. Holding Alt will replace the object, but the new object will be 
normally sized as if created from the create menu.

Holding Alt while adding a tree button will bring up a list of tree presets not found in the normal presets menu. 
Holding Alt while adding a light will bring up a prompt for a light gradient. Holding Alt while adding a terrain will 
instantly bring up the Terrain Editor. 

Holding Alt while pressing the main Render button will render the scene as an Animation. Holding Shift while 
pressing the main Render button will bring up the last render. Holding Ctrl while pressing the main Render button 
will render in fast mode. Holding Ctrl or Alt while dragging the Trackball will move the camera only sideways or up 
and down respectively. This also applies to the camera move controls.

sshhhhh!



Features: Alt+More
Holding Alt while dragging the FOV or Banking control will prevent it from changing. Holding Alt while pressing the 
Select Views control will change the camera back to the Director’s View. Holding Ctrl while in Flyaround mode will 
let you change FOV. Holding Shift while in Flyaround mode will slow down the spinning and let you control it.

Holding Alt while clicking on the Zoom In, Zoom Out, or Drag controls will reset the camera. Holding Ctrl while 
clicking the Depth Cue will toggle between the normal Depth Cue and the maximum depth cue. Holding Alt while 
using the Scrub Time control lets you move the time in your animation without the viewport changing.

Holding Alt while clicking any of the controls on the Sky&Fog will disable them. For example, Alt+Clicking Shadow 
Intensity will disable shadows, Alt+Clicking Fog Height will disable fog, Alt+Clicking Haze Intensity will disable 
haze, and Alt+Clicking any of the cloud controls will disable clouds. Alt+Clicking any colour control in Bryce will 
bring up a colour slider for more control. The pop-up allows you to swap between an Red Green Blue, Hue Saturation 
Value, Hue Lightness Saturation, and Cyan Magenta Yellow slider set.

There’s probably even more secret added controls in other sections like the Material Lab and Sky Lab, so play around 
with it! Where there’s a button, there’s a cool unique thing that happens when Ctrl, Alt, or Shift clicked.

…



Features: Utilizing Links

The Links tab at the top of the window contains links to helpful Bryce resources. However, since 
most of these links lead to Daz’s website, and because Daz doesn’t really support their Bryce 
related websites apart from the shop listing and some other examples, these websites don’t work.

However, you can change the links on the menu, and there are instructions to do so directly on 
the Links menu.

I have made a custom file containing a load of resources for Bryce. This includes tutorial websites 
and youtube channels, places for assets, programs for Bryce like Wings 3d, and even links to the 
#bryce3d hashtag on Instagram, if inspiration is running dry!

It can be downloaded here. Just replace the “Bryce Links.txt” file with the download.

Even if you don’t want to use it, I’d really recommend checking out some of the links in the file, 
especially the tutorials, and especially David Brinnen’s youtube chan

https://drive.google.com/file/d/1F4RAL0cCfUBd_GA2wcVfkT-PWkfNNqdR/view?usp=sharing


The theory of Bryce
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Why do people Love this Artstyle?
It’s a genuine question. Why?

Well, I believe there are a couple of reasons, one of the main ones being Nostalgia. Most 
people have at some time have witnessed art that looks like the art made using Bryce. It 
unlocks memories past! Whether it was an old game with smooth but primitive 
graphics or a wacky image on the back of your Trapper Keeper, you’ve seen it.

Another reason may be appeal. In a time where computers can produce something that 
could convince one it was real (not even with the use of AI, mind you), it’s good to see 
something blatantly old and computer-crafted. Also, as mentioned at the beginning of 
this book, the style of Bryce is too good to be ugly. Obviously it is possible to make 
something unpleasing with it, but the artstyle allows more things - things that a 
realistic render would prohibit -  to slide.

The “Bryce Artstyle” or “Aesthetic” or “Y2K Graphic Style” or whatever you want to call 
it will always look good and nostalgic unless the artist has purposely worked against 
that. Or at least that’s what I believe.

A render by @pyrmoboid

https://www.instagram.com/pyrmoboid/


…what now?
You’ve got a basic but powerful to create beautiful renders 
(Bryce, of course), as well as a target audience to that (people 
who are into the style). Now, you can begin, but remember this 
golden rule: if applied correctly, the renders in Bryce (and 
old-looking renders in general) can be used for anything. 
Pretty unoriginal, but it’s true.

But specifically, what can you do with Bryce? Well, this next 
section talks on just that, or specifically how to use Bryce for 
Animation, Game Making, General Art, Covers and 
Poster, and everything else! In addition to that, some 
tools, Bryce alternatives, and other things will be mentioned. 
Of course, the uses for Bryce is not limited to the things in 
bold. This section is filled with examples of the concepts 
mentioned. Hopefully they provide to you examples of the 
concepts being used to their greatest potential! “icbwiao” by @nakavelli. 

https://www.instagram.com/nakavelli/


Animation
I’ll only touch on this briefly, but you can do a lot in terms of animation in Bryce. 
Shorts, films, shows, you name it! If you have the drive, patience, and perseverance for 
it, you can do it, and that generally applies to everything in life.

However, there are no rigs in Bryce! This is an issue, as it limits what you can 
animate… or does it?

Yes, you can rig in Bryce. It has to be done manually, but it sounds harder than it is. 
Simply put, by using the Linking tool, you can create a rig.

If you don’t have a model already, start with the torso (every body part will need to be 
its own object). Then backarms, forearms, and hands. Hips, legs, feet. Neck, and the 
head. Then, starting from the object farthest to the torso (foot, hand, head), link it to 
its nearest body part (link the feet to the lower legs, link the hands to the forearms, 
link the head to the neck). Then do the same for the rest of the objects until every 
object is moving when just the torso is moved. That’s a rig, or at least as good of a rig 
as you can get.

A frame from my 
animation “Candy 
Strands.”



Putting things in Motion

Remember that the Camera object needs to be used to animate the camera. Also, 
expect to be waiting a while for renders. Every single frame is fully render.

Also, concerning the characters of your animation. Unless they are made in a 
different program like Blender and look okay, NEVER make a human character 
rig as your first animation. It’s very difficult to get a human looking well when 
animated. Unless you use metaballs (which has its own issues) the human will 
look lumpy thanks to the primitive shaped being used. To start, I highly 
recommend making robots. With robots, you can excuse things like spheres 
residing in between the fore and back arm.

If you want proof that this has been done well, just search “Bryce 3d Animation” 
on YouTube. You’ll be bombarded with amazing animation after another.

A frame from an animation of mine. It’s 
supposed to be an Animusic style animation.



Game Making
Games like Myst use rendered images instead of rendering a 3d scene. This is 
one of the main uses for renders like the ones from Bryce. They can act as the 
scene, or even as a pre-rendered background (like the older Resident Evil 
games). So if you want to make a game that mainly uses Bryce assets, a 
point-and-click style game is a pretty great option.

If you need inspiration, check out @kenopsia.game on Instagram and their 
game, which features beautiful and immersive renders (and even rendered 
animations!).

If point-and-click games aren’t your thing, you can always try something else. 
Off the top of my head, RPGs, Rhythm Games (more like Rhythm Heaven and 
less like Guitar Hero or a game with the inputs present), Visual Novels, 
Microgame Collection (like WarioWare), Puzzle Games, and other Story games 
similar to a point-and-click adventure like KinitoPet could all feasibly be made, 
and there’s probably a lot more!

Both renders are from the game Kenopsia, a 
point-and-click game set in an abandoned 
MMO. In game, these renders are animated too!

https://www.instagram.com/kenopsia.game/?next=%2F


Posters and Covers
When rendering a scene, Bryce presents an interesting value that you can 
change, being Print Resolution and Output Size in Inches. These hint at being 
able to use the renders from Bryce as posters, and naturally you could do that!

Covers are also another option. The aesthetic is there, and it’s pretty pleasing, so 
I’d bet Bryce artwork would work well in terms of attracting people. In general, 
any advertising done with Bryce could attract people depending on the product.

@zer0rei_’s own framed work. 
Looks even better in real life!

@pyrmoboid’s piece. It isn’t 
a physical piece, but 
something like this would 
look great as a printed 
poster, and that goes for a 
lot of things made in Bryce!

https://www.instagram.com/zer0rei_/
https://www.instagram.com/pyrmoboid/


General Art
Bryce is a tool for making art. It’s barely limiting, so you can make whatever you 
want!

You may want to embrace the wackiness and old look of Bryce by making 
something more digital and sci-fi-esc. Most of the materials in Bryce 
(particularly the ones from the Metals and Effects sections) are perfect for a 
spacey feel!

You may also want to embrace its retroness, and lean more into a gaming or 
computing theme. Perhaps something N64, GameCube, or PS1 related could 
appear, or even something from the Wii and DS era. Why not?

Of course, you may want to pursue a realistic and natural looking scene. Bryce 
lets you place trees and rocks, and has powerful tools for clouds and water. Tools 
like the Instancing Lab will let you place a mass of flowers, or a ton of pebbles. If 
you are willing to sacrifice some of your time, the end result will be worth it.

Or maybe you don’t want to do any of that. That’s fine! Create whatever pleases 
you!

Top is “Comfort” and bottom is “Infestation” 
both by @floatingorb_maxc.

https://www.instagram.com/floatingorb_maxc/


Tools to Assist Creation

Bryce already provides some great 
features, but it’s missing a lot. 
However, with the help of some 
other programs, you can excel the 
art you make in it. For example, take 
the Ivy Generator, a program that 
allows you to create vines around an 
imported object. David Brinnen has 
a great tutorial on how to use it with 
Bryce.

Ivy Generator + HDRI = Beautiful!
...and long render time…

The Ivy Generator isn’t the only 
software capable of producing 3d 
models rich with vegetation. I would 
argue it is the simplest, but there are 
countless alternatives.@nakavelli’s “グランジテープ  no text,” which 

incorporates a strong nature theme.

https://graphics.uni-konstanz.de/~luft/ivy_generator/
https://www.instagram.com/nakavelli/


To Poly or not To Poly
Programs like Blender, Wings3d, and pretty much any other 3d modelling 
software can be used in Bryce. Objects imported to Bryce can be set to be 
smooth or not. This is something not possible with regular Bryce primitives, 
which are always smooth.

Just like choosing whether you render your scene with Anti Aliasing or not, 
choosing for your models to be more low-poly than smooth is mainly just a 
stylistic choice.

With tools like Blender, you can also create much more complex primitives, 
something only possible by grouping primitives in Bryce.

The render on the left demonstrates this well. It is rendered in Blender, and 
yet it doesn’t look realistic, which is intentional. Things like high-poly vs 
low-poly or anti aliasing vs no anti aliasing aren’t a mark of quality but 
rather purely stylistic decisions. A render by @disillusion.st. Note the choice to 

not make a hyper-realistic render. 

https://www.instagram.com/disillusion.st/


Bryan (or Bryce Alternatives)
Of course, there are some alternatives to Bryce, although rather than “alternatives,” 
they’re more software that an alternative to one or more specific aspects of Bryce.

Software like TerraGen and Vue allow you to create absolutely stunning renders, and 
are still somewhat intuitive, with Vue having a materials lab similar to Bryce. They 
aren’t as beginner friendly as Bryce, but are definitely worth checking out.

Other software like POVRay allow the creation of renders with a similar style to Bryce 
(specifically Bryce 3). Again, they aren’t as beginner friendly, but are interesting 
nonetheless.

If Bryce’s terrain generation is all you’re interested in, there are countless alternatives, 
such as the mentioned Vue and Terragen, as well as World Machine, Picogen, and 
FlowScape, with all but Picogen being free to use.

Of course, any 3d rendering program is a substitute for Bryce, even if more effort is 
required to emulate Bryce’s retro look.@zer0rei_’s “Grassy Field,” which 

was made with TerraGen

https://www.instagram.com/zer0rei_/


Inspiration

If you need some inspiration from others, I’ve got you 
covered.

Check out Bryce content on Instagram, YouTube, and 
anywhere else you can! Seeing what someone has been able 
to do with the program could motivate you to try making 
something on par. Obviously you shouldn’t try to be exactly 
as good as others, but instead be inspired at what they 
could do, and try out what they are doing. I know it’s vague, 
but seeing others’ content is “eye-opening” in a way.

Additionally, check out David Brinnen and Horo on 
YouTube. They make great tutorials, and everytime I watch 
one of their videos I learn something new. Amazing, right?

Top is “Plasma Water Tube” by 
@ephemeral_dimensions and bottom 
is “Maximalist” by @floatingorb_maxc.

“Reality Check 3” by 
@enigmaworld_org

https://www.instagram.com/ephemeral_dimensions/
https://www.instagram.com/floatingorb_maxc/
https://www.instagram.com/enigmaworld_org/


More Inspiration

“Seismic Thirst” by 
@ephemeral_dimensions

A piece by @enigmaworld_org

A piece by @shawtythepimp

Another piece by @shawtythepimp

https://www.instagram.com/ephemeral_dimensions/
https://www.instagram.com/enigmaworld_org/
https://www.instagram.com/shawtythepimp/?g=5
https://www.instagram.com/shawtythepimp/?g=5


Ending Remarks
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Meet the Artists
The last section was brought to life by creative and talented artists, who were generous enough to give me permission 
to use their art as examples! If you liked the art showcased, check out the artists on their instagram accounts, where 
they post similar content.

Nakavelli (@nakavelli)

Ian (@ephemeral_dimensions)

https://www.instagram.com/nakavelli/
https://www.instagram.com/ephemeral_dimensions/


Meet the Artists

Max (@floatingorb_maxc)

STP TV (@shawtythepimp)

https://www.instagram.com/floatingorb_maxc/
https://www.instagram.com/shawtythepimp/


Meet the Artists

Jamie Norton (@kensopia.game)

Rick Tempest (@disillusion.st)

https://www.instagram.com/kenopsia.game/
https://www.instagram.com/disillusion.st/


Meet the Artists

André (@enigmaworld_org)

PyrMoboid (@pyrmoboid)

https://www.instagram.com/enigmaworld_org/
https://www.instagram.com/pyrmoboid/


Meet the Artists

Zer0 Rei (@zer0rei_)

As well as providing the Terragen render seen on the right, Zer0 Rei 
also reviewed the book as I was writing it, and gave feedback and 
suggestions, as well as some Bryce 3d feature corrections!

Without Zer0 Rei, this book may have turned out slightly or very 
different, and would also contain some inaccuracies, so I’m thankful 
to have such a Bryce guru editing this!

https://www.instagram.com/zer0rei_/


Meet Me + Other Notes

Super Render 64 (@superrender64)

I also occasionally make renders too! Usually it’s animated stuff, or something else 
random. 

I’m not going to ask you to follow me, but I will ask you to share this book around! I 
would greatly appreciate it!

Also, I plan to keep updating this book with suggestions from you, the reader. If you 
do have feedback or a suggestion, please let me know by message me on Instagram or 
commenting on my pinned post!

https://www.instagram.com/superrender64/


Parting Words
And that’s it, at least for now!

This book has been a while in the making, and after shifting my perspective a bit, we’ve reached here!

Hopefully I have succeeded in at least teaching you something new, or entertaining you about Bryce. Go forth and 
making something unique, retro, and beautiful!


